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รู้จักกับโปรแกรม Adobe Illustrator CC

Illustrator คือ โปรแกรมที่ใช้ในการวาดภาพ โดยจะ
สร้างภาพที่มีลักษณะเป็นลายเส้น หรือที่ เรียกว่า 
Vector Graphic จัดเป็นโปรแกรมระดับมืออาชีพที่ใช้
กันเป็นมาตรฐานในการออกแบบระดับสากลสามารถ
ท างานออกแบบต่างๆ ได้หลากหลาย ไม่ว่าจะเป็น
สิ่งพิมพ์ บรรจุภัณฑ์ เว็บ และภาพเคลื่อนไหวตลอดจน
การสร้างภาพเพื่อใช้เป็นภาพประกอบในการท างานอื่นๆ 
เช่น การ์ตูน ภาพประกอบหนังสือ



งานที่ออกแบบด้วยโปรแกรม Adobe Illustrator CC

บรรจุภัณฑ์

โลโก้

สิ่งพิมพ์

เว็บไซต์



อะไรคือ Adobe Creative Cloud?



อะไรคือ Adobe Creative Cloud?

Adobe Creative Cloud คือ ชุดโปรแกรมจากค่าย 
Adobe ที่ได้รวบรวมเอาเครื่องมือทุกอย่างที่ต้องการ
ส าหรับนักออกแบบกราฟฟิก หรือ Creative เพื่อใช้
เนรมิตสร้างสรรค์ผลงานที่ดีที่สุดออกมา โดยสามารถ
ท างานได้ทั้งบนหน้าเครื่องคอมพิวเตอร์เดสก์ท็อป และ
บนคลาวด์ (Cloud) ซึ่งจะสามารถเชื่อมต่อหรือแชร์ไฟล์
ผลงาน รวมทั้งสร้างและแก้ไขไฟล์ได้ทุกที่ทุกเวลา



Adobe Creative Cloud ดีอย่างไร?

- Upgrade โปรแกรมเวอร์ชั่นใหม่ๆ ได้ฟรีตลอดอายุการใช้งาน
- สามารถ update โปรแกรม patch ปรับปรุง plugin หรือ Feature ใหม่ๆ ได้ตลอดอายุ

การใช้งาน
- ฟรี พื้นที่เก็บไฟล์ออนไลน์  Cloud storage สูงสุดถึง 100 GB สามารถเก็บไฟล์งานที่ส าคัญ  

หรือแชร์ไฟล์งานต่อให้เพื่อนร่วมงานได้จากทุกๆ ที่และทุกๆ device สะดวกรวดเร็วต่อการ
สร้างสรรค์งานยิ่งขึ้น

- มี Admin Console เพ่ือให้คุณ Manage License ของเราได้ เช่น การเพ่ิม ลบ 
เปลี่ยนแปลงสิทธ์ิการใช้งาน ของ user ได้

- มี Expert Support จาก Adobe โดยตรง รวมถึง Support จาก I.T. Solution 
Computer(Thailand) Co.,Ltd. เองด้วย เพื่อที่จะรับปรึกษาหรือแก้ปัญหา ไม่ว่าจะเป็น
ในส่วนของการใช้งานโปรแกรม หรือในส่วนของการติดตั้งโปรแกรม ฯลฯ



สวนประกอบของหนาจอ

โปรแกรม Adobe Illustrator



คอนโทรลพาแนล (Control Panel) แถบเมนูคำสั่ง

กลองเครื่องมือ (Tool Box) พื้นที่การทำงาน (Artboard) พื้นที่ภายนอก (Scratch area)
ใชวางพักวัตถุที่ยังไมไดใชงานในขณะนั้น

กรอบจัดเก็บพาเนล (DockPanel)



File: เปนหมวดของคำสั่งที่จัดการเกี่ยวกับไฟลและโปรแกรมทั้งหมด ไมวาจะเปนการ เปด-ปดไฟล การ บันทึกไฟล การนำภาพเขามาใช (Place) 

ตลอดจนการออกจากโปรแกรม (Exit)

Edit: เปนหมวดของคำสั่งที่จัดการแกไข เชน Undo Cut Copy Paste Select รวมทั้งการกำหนดคุณสมบัติ ตางๆ ที่มีผลตอการปรับแตงภาพดวย 

เชนการสรางรูปแบบ (Define Pattern) การกำหนดคาสี (Color Setting) เปนตน

Type: เปนหมวดของคำสั่งที่ใชจัดการตัวหนังสือ เชน Fonts Paragraph เปนตน

Select: เปนหมวดของคำสั่งที่ใชในการเลือกวัตถุ สามารถเลือกดวยคุณสมบัติได เชน เลือกวัตถุที่มี Fill และ Stroke แบบเดียวกัน 

วัตถุที่อยูบน Layer เดียวกัน เปนตน

Filter: เปนหมวดของคำสั่งที่ใชสรางเทคนิคพิเศษใหกับภาพ โดยจะมีผลตอรูปรางของ Path

Effect: เปนหมวดของคำสั่งที่ใชสรางเทคนิคพิเศษใหกับภาพคลาย Filter แตจะไมมีผลกับรูปรางของ PathView: เปนหมวดของคำสั่งเกี่ยวกับ

การมองทุกสิ่งในงาน เชน Zoom Show/Hide Ruler Bounding Box Outline Mode/Preview Mode เปนตน

Window: เปนหมวดของคำสั่งเกี่ยวกับการเปด-ปดหนาตางเครื่องมือตางๆ เชน Palette Tool Box เปนตน

Help: เปนหมวดที่รวบรวมวิธีการใชงานและคำแนะนำเพื่อชวยเหลือผูใชโปรแกรม



คอนโทรลพาเนล (Control Panel)

เปนแถบตัวเลือกสำหรับกำหนดคาตางๆ ของวัตถุ เพื่ออำนวยความสะดวกแกผูใชใหสามารถกำหนดคาสี ขนาด ตำแหนง 

และคุณสมบัติตางๆ ของวัตถุที่เลือกไดงายขึ้น

พาเนลควบคุมการทำงาน (Panel)

เปนหนาตางยอยที่รวบรวมคุณสมบัติการทำงานของเครื่องมือตางๆ ใหเรา

เลือกปรับแตงการใชงานไดงายๆ ไมตองเปดหาแถบคำสั่ง ซึ่งพาเนลจะถูกจัดเก็บไวใน

กรอบจัดเก็บพาเนลดานขวาของหนาจอ



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

ด้วย Adobe Illustrator



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

Line Tool คือเครื่องมือส าหรับวาดเส้นตรง โดยเราสามารถก าหนดความยาวและองศา
ของเส้นให้เอียงไปยังทิศทางที่ต้องการได้ด้วย การใช้งานท าได้ดังนี้

คลิกเครื่องมือ (Line Tool) 1

คลิกเลือกขนาดของเส้น

คลิกเลือกขนาดของเส้น

คลิกเลือกสีขาว

2

3

4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

คลิกที่จุดแรกค้างไว้ 5

แดรกเมาส์มาอีกจุด6



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

ปล่อยเมาส์จะได้เส้นตรง 7



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

ท าตามขั้นตอนเดิมจนไดภ้าพตามตวัอย่าง8



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

เราสามารถรวมเส้นเข้าด้วยกันได้โดยใช้เครื่องมือ       (Direct Selection Tool)
แดรกเมาส์ เลือกจุดแองเคอร์ทั้งสองจุด จากนั้นคลิกขวาแล้วเลือกค าสั่ง Join

เลือกค าสั่ง Join



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

นอกจากการแดรกเมาส์สร้างเส้นตรงแล้ว ยังก าหนดค่าเพ่ือสร้างเส้นตรงได้ทั้งความยาวเส้น
และองศาการเอียงเส้น โดยใช้เครื่องมือ       (Line Tool) คลิกลงบนอาร์ตบอร์ด  เปิดหน้าต่าง
การก าหนดค่าขึ้นมา เพ่ือปรับแต่งค่าต่างๆ ได้เช่นกัน

หลังจากก าหนดค่าใน Line Segment Tool Options เพ่ือสร้างเส้นตรงแล้ว  จะเห็นว่า
เส้นที่ได้เป็นเส้นเปิด ท าให้ลงสีไม่ได้ เราสามารถแปลงคุณสมบัติของเส้นให้กลายเป็นเส้นปิดได้ 
ดังนี้ ก าหนดความยาวเส้นที่ต้องการ

ก าหนดองศาการเอียงเส้น

ก าหนดให้ใส่สีพื้นของเส้น



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Arc Tool

เครื่องมือ       (Arc Tool) ใช้ส าหรับสร้างเส้นโค้ง สามารถน ามาเชื่อมต่อกันให้เกิดเป็น
รูปภาพได้หลายรูปแบบ ดังนี้

ก าหนดค่าเริ่มต้นให้เส้น
เลือกสีและขนาดที่ต้องการ 2

คลิกเครื่องมือ 1

คลิกแล้วแดรกเมาส์สร้างเส้นโค้ง 3 เมื่อปล่อยเมาส์จะได้เส้นโค้ง4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Arc Tool

เราสามารถปรับแต่งเครื่องมือ       (Arc Tool) ให้สร้างรูปทรงแบบปิด พร้อมกับใส่สีพื้น
ลงไปในภาพได้ ให้เปิดหน้าต่างการปรับแต่งโดยใช้       (Arc Tool) คลิกลงไปบนอาร์ตบอร์ด
มีค่าการปรับแต่งดังนี้

เลือกประเภทรูปทรงรูปทรง
เป็นแบบเส้นเปิดหรือเส้นปิด

เลือกจุด Reference 
ส าหรับจุดเริ่มต้นเส้นโค้งก าหนดความยาวเส้น

ตามแนวตั้ง และแนวนอน

เลือกด้านที่เป็น
ฐานของรูปทรง

เลือกด้านที่เป็น
ฐานของรูปทรง

ก าหนดค่าความ
โค้งของมุมเส้น



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นเส้นโค้งรูปก้นหอยด้วย Spiral Tool

เครื่องมือ      (Spiral Tool) ใช้ส าหรับสร้างเส้นโค้งรูปก้นหอย ที่มีลักษณะหมุนวนจาก
ตรงกลาง แล้วค่อยๆคลายเส้นให้หลวมออกมาด้านนอก มีหลักการง่ายๆคือ แดรกเมาส์ไปบน
อาร์ตบอร์ดเพื่อก าหนดรัศมี ดังตัวอย่าง

เลือกสีเส้นและ
ขนาดที่ต้องการ 2

เลือกเคร่ืองมือ
Spiral Tool 1

คลิกแล้วแดรกเมาส์
เพ่ือสร้างเส้นโค้ง 3

เมื่อปล่อยเมาส์
จะได้เส้นโค้ง4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นเส้นโค้งรูปก้นหอยด้วย Spiral Tool

สามารถปรับแต่งค่า ก าหนดความโค้ง หรือความหนาแน่นของเส้นโค้งในจุดศูนย์กลางได้      
ให้ใช้เครื่องมือ       (Spiral Tool) คลิกลงไปบนอาร์ตบอร์ดแล้วก าหนดค่าต่างๆ ดังนี้

รัศมีหรือขนาดของรูปทรง

ก าหนดค่าเพ่ือควบคุมการม้วนของเส้น

ก าหนดค่าเพ่ือควบคุมความแน่น ของเส้นโค้งบริเวณจุดศูนย์กลาง

เลือกรูปแบบการหมุนเสน้



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นเส้นโค้งรูปก้นหอยด้วย Spiral Tool

หลังจากปรับแต่งค่าบนหน้าต่างค าสั่ง Spiral แล้ว ผลลัพธ์จะมีความแตกต่างกัน ดังนี้

Decay 80%
Segments 10

Decay 80%
Segments 20

Decay 80%
Segments 40

Decay 80%
Segments 60

Decay 80%
Segments 80

Decay 80%
Segments 100

Decay 10%
Segments 10

Decay 20%
Segments 10

Decay 30%
Segments 10

Decay 40%
Segments 10

Decay 50%
Segments 10

Decay 80%
Segments 10



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดตารางสี่เหลี่ยมด้วย Rectangular Grid Tool

การสร้างตารางสี่เหลี่ยม มักน าไปใช้ร่วมกับการจัดระเบียบข้อความ หรือน าไปใช้สร้างเป็น
ลวดลาย Pattern มีหลักการสร้างดังต่อไปนี้

เลือกสีเส้นและ
ขนาดที่ต้องการ 2

คลิกเครื่องมือ
Rectangular Grid Tool

คลิกแล้วแดรกเมาส์เพ่ือ
สร้างตาราง

1

3

เมื่อปล่อยเมาส์จะได้ตาราง 4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดตารางสี่เหลี่ยมด้วย Rectangular Grid Tool

เราสามารถก าหนดค่าให้เครื่องมือ       (Rectangular Grid Tools)  ไม่ว่าจะเป็นขนาด
ตาราง จ านวนแถว หรือจ านวนคอลัมภ์ ใช้เครื่องมือ      (Rectangular Grid Tools) คลิก
ลงไปบนอาร์ตบอร์ด พร้อมกับปรับแต่งค่าต่างๆดังนี้

รัศมีหรือขนาดของรูปทรง

ก าหนดจ านวนแถวให้ตาราง
พร้อมกับก าหนดค่าความถี่ให้

ด้านบนหรือด้านล่างของตาราง

ก าหนดจ านวนคอลัมน์ให้ตาราง
พร้อมกับก าหนดค่าความถี่ให้

ด้านซ้ายหรือด้านขวาของตาราง

คลิกเพื่อใส่สีพื้นให้ตาราง
คลิกเพื่อสร้าง Bounding Box 
ส าหรับปรับขนาดตารางทีก่รอบนอก



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดตารางตารางวงกลมด้วย Polar Grid Tool

(Polar Grid Tool) เป็นเครื่องมือสร้างตารางแบบวงกลมเพื่อน าไปใช้สร้างกราฟ
หรือใช้ร่วมกับการออกแบบอื่นๆ มีวิธีการาร้างดังนี้

เลือกสีเส้นและ
ขนาดที่ต้องการ 2

เลือกเคร่ืองมือ
Polar Grid Tool1

คลิกแล้วแดรกเมาส์
เพ่ือสร้างเส้นตาราง 3

เมื่อปล่อยเมาส์จะได้ตาราง 4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดตารางตารางวงกลมด้วย Polar Grid Tool

หลังจากสร้างตารางวงกลมขึ้นมาแล้ว การปรับแต่งจะท าได้ค่อนข้างจ ากัด หากต้องการ
ปรับเปลี่ยนสี หรือสร้างลวดลายให้สวยงามขึ้น สามารถท าได้ดังนี้

คลิกเลือก Fill และ Stroke
เพ่ือแยกวัตถุเป็นสีพื้นและสีเส้น

คลิกเมนู Object > Expand 1

2

คลิกปุ่ม OK 3

ใส่สีพื้นให้ตาราง
ได้ตามต้องการ 4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
กลุ่มเครื่องมือดินสอวาดภาพ 

ด้วย Adobe Illustrator



กลุ่มเครื่องมือดินสอวาดภาพ 
กลุ่มเครื่องมือดินสอวาดภาพมีทั้งหมด 3 ตัว มีหน้าที่แตกต่างกันคือ ใช้วาดเส้น ปรับเส้น

ให้โค้งมน และการตัดบางส่วนของเส้นออก มักน าไปใช้ในการสร้างเค้าร่าง สามารถแดรกเมาส์
ก าหนดเส้นได้อย่างอิสระ 

เลือกสีเส้นและขนาดที่ตอ้งการ 2

คลิกเครื่องมือ Pencil Tool 1

คลิกเครื่องมือ Pencil Tool 3



กลุ่มเครื่องมือดินสอวาดภาพ 
เราสามารถปรับแต่งค่าเริ่มต้นให้เครื่องมือ     Pencil Tool ได้ เพื่อให้ใช้งานสะดวก

ยิ่งขึ้น โดยดับเบิลคลิกที่เครื่องมือแล้วปรับแต่งค่าต่างๆ ดังต่อไปนี้

เพ่ิมหรือลดความนุ่มนวลของเส้น

เพิ่มหรือลดความนุ่มนวลของเส้น
แสดง Select บนเส้น
หลังจากใช้เครื่องมือแล้ว

คลิกพร้อมทั้งระบุระยะห่างให้เส้น
Path ที่วาดใกล้กันให้เหลือเพียง
เส้นเดียวหรือคลิกยกเลิกเพื่อวาด

เส้นทันกันก็ได้

คลิกเพื่อเรียกค่าเดิมกลับมา



กลุ่มเครื่องมือดินสอวาดภาพ 
เราสามารถประยุกต์ใช้เครื่องมือ     Pencil Tool วาดภาพเหมือนได้โดยน าภาพถ่ายมา

วางไว้บนอาร์ตบอร์ด ก าหนดเป็นแบบ Template หลังจากนั้นใช้เครื่องมือ    Pencil Tool
วาดเส้นแล้วน าไปตกแต่งให้สวยงามด้วยค าสั่งต่างๆ 



ปรับเส้นให้เรียบขึ้นด้วย Smooth Tool

ปรับแต่งคุณสมบัติของเครื่องมือ     Smooth Tool ดับเบิลคลิกเครื่องมือแล้วก าหนด
ค่าดังนี้

ก าหนดระยะห่างระหว่างจุด Anchor 
ค่ายิ่งสูง จุด Anchor จะน้อยลง 

เส้นจะเรียบเนียนขึ้น

คลิกเพื่อเรียกค่าเดิมกลับมา



ตัดเส้น Path ทิ้งด้วย Path Eraser Tool 

นอกจากการสร้างเส้นและปรับเส้นให้เรียบเนียนแล้ว บางครั้งอาจต้องลบบางส่วนทิ้งไป
ซึ่งสามารถใช้เครื่องมือ     Path Eraser Tool ช่วยได้ โดยมีวิธีการใช้งานง่ายๆ ดังนี้

คลิก Path
Eraser Tool

1

แดรกเมาส์ลบเส้น 
Path ออกไป

กดปุ่ม Ctrl แล้วคลิกเลือก    
ที่ท างานกับเส้น Path

2

3

เส้น Path จะถูกลบออก4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
กลุ่มเครื่องมือส าหรับวาดรูปทรงเรขาคณิต

ด้วย Adobe Illustrator



กลุ่มเครื่องมือส ำหรับวำดรูปทรงเรขำคณิต
เครื่องมือวำดรูปทรงพื้นฐำน มี 3 แบบคือ

Rectangle Tool : ส ำหรับวำดรูปสี่เหลี่ยม
Rounded Rectangle Tool : ส ำหรับวำดรูปสี่เหลี่ยมขอบมน
Ellipse Tool  : ส ำหรับวำดรูปวงกลม

เลือกสีเส้นและ
ขนาดที่ต้องการ 2

คลิกเครื่องมือ
ที่ต้องการใช้งาน

1

แดรกเมาส์สร้างรูปทรง 3 เมื่อปล่อยเมาส์จะได้    
รูปทรงที่ต้องการ

4



กลุ่มเครื่องมือส ำหรับวำดรูปทรงเรขำคณิต
ตัวอย่ำงกำรใช้เครื่องมือ      Rounded Rectangle Tool

และเครื่องมือ Ellipse Tool  



วำดรูปหลำยเหลี่ยมด้วย Polygon Tool
Polygon Tool เป็นเครื่องมือส ำหรับวำดรูปหลำยเหลี่ยม ก ำหนดได้ตั้งแต่สำมเหลี่ยม

เป็นต้นไป วิธีใช้งำนเครื่องมือ ท ำได้ดังนี้

เลือกสีเส้นและ
ขนาดที่ต้องการ

2

คลิกเครื่องมือ
Polygon Tool

1

แดรกเมาส์สร้างรูปทรง   
โดยยังไม่ปล่อยเมาส์

3

กดปุ่มลูกศรข้ึนหรือลงที่คีย์บอร์ด
เพ่ือเพ่ิมหรือลดเหลี่ยมของรูปทรง

4 เมื่อปล่อยเมาส์จะ
ได้รูปทรงที่ต้องการ

5



วำดรูปหลำยเหลี่ยมด้วย Polygon Tool
กำรก ำหนดค่ำจ ำนวนเหลี่ยมมุมของรูปทรง        (Polygon Tool) ยังสำมำรถท ำได้โดย กำรคลิกลงไปบน

อำร์ตบอร์ด 

ก าหนดขนาดของรูปทรง

ก าหนดจ านวนเหลี่ยม
ของรูปที่ต้องการ



วำดรูปดวงดำวด้วย Star Tool

เลือกสีเส้นและ
ขนาดที่ต้องการ

2

คลิกเครื่องมือ
ที่ต้องการใช้งาน

1

แดรกเมาส์สร้างรูปดาว 3 เมื่อปล่อยเมาส์จะ
ได้รูปดาวที่ต้องการ

4



วำดรูปดวงดำวด้วย Star Tool

คลิกแล้วแดรกเมาส์
สร้างรูปดวงดาว

1

สามารถคลิก Ctrl เพื่อควบคุมความยาวของแฉกดาวได้อีกด้วย

กดปุ่ม Ctrl ค้างไว้ แล้ว
แดรกเมาส์เข้าหรือออก

2

สามารถเพิ่มขนาดเส้น  
และสีของดวงดาวได้

3



วำดรูปดวงดำวด้วย Star Tool

คลิกแล้วแดรกเมาส์
สร้างรูปดวงดาว

1

สามารถคลิก Ctrl เพื่อควบคุมความยาวของแฉกดาวได้อีกด้วย

กดปุ่ม Ctrl ค้างไว้ แล้ว
แดรกเมาส์เข้าหรือออก

2

สามารถเพิ่มขนาดเส้น  
และสีของดวงดาวได้

3



วำดแฟลร์ด้วย Flare Tool
แฟลร์ หรือ Flare Tool ลักษณะของแสงกระทบวัตถุให้เกิดวงของแสง หรือประกายแสง สามารถใช้งาน

เครื่องมือ          (Flare Tool)

คลิกเครื่องมือ
Flare Tool

1

คลิกแล้วแดรกเมาส์     
ก าหนดขนาดแฟรท์ี่

ต้องการ แล้วปล่อยเมาส์
2



วำดแฟลร์ด้วย Flare Tool

กดปุ่มลูกศรขึ้นหรือลง เพ่ือเพ่ิมหรือ  
ลดจ านวนแสงสะท้อนของแฟร์

4

คลิกแล้วแดรกเมาส์ที่จุดใหม่     
เพ่ือสร้างแสงสะท้อนของแฟร์

3



วำดแฟลร์ด้วย Flare Tool

กดปุ่มลูกศรขึ้นหรือลง เพ่ือเพ่ิมหรือ  
ลดจ านวนแสงสะท้อนของแฟร์

4

คลิกแล้วแดรกเมาส์ที่จุดใหม่     
เพ่ือสร้างแสงสะท้อนของแฟร์

3

เมื่อปล่อยเมาส์จะได้แฟลรด์ังภาพ5





การใชงาน Pen Tools
ภาพตางๆที่เราสรางใน Illustrator จะประกอบดวยเสน Path มากมาย เสน  Path เหลานี้จะถูกนำมาประกอบเขาดวยกันเปน

รูปรางที่ตองการ เสน Path เหลานี้สวนใหญจะถูกสรางจากเครื่องมือ        (Pen Tools) ซึ่งเปนเครื่องมือที่สามารถนำไปใชใน

งานการาฟคไดหลากหลาย และนำไปประยุกตใชกับงานตางๆ ไดมากมาย ดังภาพตัวอยาง



เริ่มตนการใชงานงานเครื่องมือ Pen tools ดวยการคลิกที่สัญลักษณ         เพื่อทำการเรียกใชงานเครื่องมือ Pen Tools

สรางเสน Path เพิ่ม Achor 

Point Path

ลบ Achor Point 

Path
ดัดมุม Achor 

Point Path

คลิกขาง

Tools Box

การใชงาน Pen Tools



ทำความรูจักกับเสน Path
กอนจะวาดรูปดวยเครื่องมือ         (Pen Tool) ตองทำความรูจักกับเสน Path กอนวามีสวนประกอบอะไรบาง เพื่อใหควบคุม

ทิศทางของเสน Path ไดงาย รวมทั้งใหสามารถวาดรูปทรงไดรวดเร็วและสวยงามยิ่งขึ้นดวย 

Direction Line คือ เสนที่ใช

ควบคุมความโคงของเสน Path 

ถาเสนยิ่งยาว เสน Path ก็จะ

โคงมาก

จุดแองเคอร ( Anchor Point) 

ที่ถูกเลือกใชงานจะเปนสีทึบ

Direction Point ซึ่งเปนจุดแสดงทิศทาง 

และใชควบคุมทิศทางของเสน Path ได

เสนโคงหรือเสนตรง (Path Segments) ซึ่ง

เปนรูปทรงของเสน Path

จุดแองเคอร (Anchor Point) ที่ไมไดเลือก

ใชงานจะเปนสี่เหลี่ยมสีขาว



ทำความรูจักกับเสน Path (ตอ)
คลิกที่        เพื่อฝกการใชเครื่องมือ Pen Tool



คลิกที่        เพื่อฝกการใชเครื่องมือ Pen Tool

ทำความรูจักกับเสน Path (ตอ)



คลิกที่        เพื่อฝกการใชเครื่องมือ Pen Tool

ทำความรูจักกับเสน Path (ตอ)



วาดรูปทรงดวยเครื่องมือ Pen Tool



วาดเสนตรงดวย Pen Tool
การสรางเสนตรงดวยเครื่องมือ        (Pen Tool) เปนวิธีที่งายที่สุด เพียงแคคลิกไปบนอารตบอรดก็จะไดเสน Path ที่เปนเสน

ตรงดังตัวอยางตอไปนี้



Work Shop : Grassed 3D 
สรางเสนตรงดวยเครื่องมือ         (Pen Tool) ตามรูป



วาดเสนโคงดวย Pen Tool
การสรางเสนโคงดวยเครื่องมือ        (Pen Tool) เปนวิธีที่งายที่สุด เพียงแคคลิกไปบนอารตบอรดก็จะไดเสน Path ที่เปนเสน

ตรงดังตัวอยางตอไปนี้

สรางเสนโคงรูปตัว U สรางเสนโคงรูปตัว S การวาดเสนตรงรวมกับเสนโคง



Work Shop | Bicycle 
สรางเสนตรงดวยเครื่องมือ         (Pen Tool) ตามรูป



Work Shop | Add Achor Point 
เพิ่มจุด Achor Pointดวยเครื่องมือ         (Add Anchor Tool) ตามรูป



ลบ Achor Point ดวยเครื่องมือ         (Delete Anchor Point Tool) ตามรูป

Work Shop | Delete Achor Point 

Tool



Work Shop | Convert Achor Point to corner 
Convert Achor Point ดวยเครื่องมือ         (Convert Anchor Point to corner) ตามรูป



-  Convert Achor Point ดวยเครื่องมือ         (Pen Tool) 

-  คลิกที่จุด Achor Point แลวไปที่         (Convert Anchor Pen Tool) 

-  ปรับแขนของจุด Achor Point  

Work Shop | Convert Achor Point 



Work Shop | Convert Achor Point 
Convert Achor Point ดวยเครื่องมือ        โดยกด ALT คางไวแลวแดรกเมาสไปยังทิศทางของจุด Direction



Work Shop | Simplify
Simplify คือ คำสั่งที่ใชแกปญหาเสน Path ที่มีรอยหยักมากๆ ใหดูเนียนเรียบขึ้น ในขณะเดียวกันก็สามารถแปลงเปนเสน Path 

ที่โคงมนใหกลายเปนเหลี่ยมมุมไดเชนกัน สามารถเรียกคำสั่งไดที่เมนู Object > Path > Simplify



Work Shop | แปลงภาพถายเปนภาพวาด
การแลงภาพบิตแมปใหเปนภาพวาด ใชคำสั่ง Image Trace คำสั่งจะคำนวณคาจากจุดสีภาพมาสรางเปนเสน Path เราสามารถ

จัดการรูปแบบไดภายหลัง ไมวาจะเปนการปรับความโคงของเสน Path การเพิ่มสีใหสวยงาม การใชคำสั่ง Image Trace 

สามารถทำไดดังนี้

1 วางรูปภาพไวบน Art Board โดยคลิกเมนู 

File > Place

2  คลิกเลือกภาพดวยเครื่องมือ Selection Tool

3 คลิกที่ปุม Image Trace บนพาแนล Control 

เพื่อแปลงภาพเปนเวคเตอร



แปลงภาพถาย

เปนภาพวาด



การจัดการวัตถุ
ดวย Adobe Illustrator



การจัดการวัตถุ : COPY

ใชเครื่องมือ Selection Tool 

คลิกเลือกวัตถุที่ตองการ Copy

1คลิกที่เมนู Edit2

คลิกเลือก Copy3

คำสั่ง วางวัตถุ4

A. วางวัตถุทั่วไป

B. วางวัตถุซอนทับตัวเดิม

C. วางวัตถุไวหลังวัตถุตัวเดิม

D. วางวัตถุไวตำแหนงเดียวกับวัตถุเดิม

F. วางวางวัตถุไวทุก ArtBoards

A

B

C
D

F



การจัดการวัตถุ : Duplicate 
: การกระทำซ้ำกับวัตถุ (Object)

ใชเครื่องมือ Selection Tool 

คลิกเลือกวัตถุที่ตองการ Copy

1

ทำการ Copy Object ออกมา 1 ครั้ง 

ดวยการคลิกวัตถุ A แลวกด alt คาง 

ใชเมาสแดรก object ออกมา จะได

วัตถุ B

2

Duplicate ไฟลดวยการกดปุม CTRL+D3

A B

A

A B D



การจัดการวัตถุ : Order
: การจัดลำดับของวัตถุ (Object)

ใชเครื่องมือ Selection Tool         คลิกเลือกวัตถุ A เพื่อจัดลำดับ1

คลิกเมาสขวา แลวไปที่เมนู Arrange2

A

B

A

C

เลือกการจัดการวัตถุตามความตองการ3



การจัดการวัตถุ : Transform

ใชเครื่องมือ Selection Tool         คลิกเลือกวัตถุ1

คลิกเมาสขวา แลวไปที่เมนู Transform2

A

เลือกการจัดการวัตถุตามความตองการ3

การเคลื่อนยายวัตถุ
การหมุนวัตถุ

การกลับดานวัตถุ

การขยาย/ลดขนาดของวัตถุ

การยืดขยายขนาดของวัตถุ



Brush
ดวย Adobe Illustrator



คลิกเลือก Brush Tool

การทำงานกับ Brush Tools

1 2 คลิกเมนู Window > Brush (F5) คลิกเลืิอก Brush ที่ตองการวาด3



คลิกเลือก Brush Library 

เพื่อเปดใชงาน Brush ชนิดอื่น

การทำงานกับ Brush Tools

4



ตัวอยางการทำงานกับ Brush Tools 



Pathfinder
ดวย Adobe Illustrator



 สรางรูป Shape ดังภาพขึ้นมา

การทำงานกับ Pathfinder

1 2 คลิกเมนู Window > Pathfinder คลิกเลืิอก การจัดการ 

Pathfinder ที่ตองการ
3

คลิกเพื่อรวมรูปทรง หรือตัดรูปทรงที่ซอนกัน

อยูในแบบตางๆ เลือกไดทั้งหมด 4  วิธี

คลิกเพื่อแยกรูปทรง ที่ซอนกันออกเปนชิ้นๆ 

เลือกไดทั้งหมด 6 วิธี

คลิกเพื่อตัดเสน Path ออกตามรูปแบบที่เรา

เลือก

 พาเนล Pathfinder คือ พาเนลสำหรัับจัดการกับรูปทรงที่วางซอนทับกัน ใหสามารถรวมกัน หรือ ตัดสวนที่ทับซอนกันออกไป 



Minus Front

การทำงานกับ Pathfinder

Intersect Exclude Devide

Trim Merge Crop Outline Minus Back

Unite



พื้นฐานการใชสี



รูจักกับสี
ในโปรแกรม Illustrator นอกจากการวาดภาพ พิมพขอความแลว ขั้นตอนที่สำคัญและขาดไมไดคือ การลงสี เชน ลงสีแบบสี

เดียว ลงสีแบบไลโทน ลงสีแบบลวดลาย Pattern เปนตน กอนที่จะเริ่มตนลงสีนั้น เราควรรูจักสีใหมากเสียกอน ดังนี้

โหมดสี



โหมดสี RGB
โหมดสี RGB หรือ สีทางแสง จะมีสีหลักคือ RED (สีแดง) GREEN (สีเขียว) และ BLUE (สีน้ำเงิน) สีทั้ง 3 จะผสมกันเปนสีขาว 

งานที่เหมาะสมกับ โหมดสี RGB เชน งานกราฟกสำหรับเว็บ หรืองานพรีเซนเตชัน



โหมดสี CMYK
โหมดสี CMYK หรือ สีทางการพิมพ จะมีสีหลักคือ Cyan (สีฟา) Magenta (สีชมพู), Yellow (สีเหลือง) และ Black (สีดำ) 

ซึ่งสีดำที่เกิดจากการผสมของสีทั้ง 3 ซึ่งเปนสีดำไมสนิท จึงตองมีสีดำมาชวยเสริม ผูใชควรเลือกใชโหมดสีนี้สำหรับ การออกแบบ

สิ่งพิมพตางๆ เพื่อปองกันปญหาสีเพี้ยน   



สีใหมที่เลือกไว

สีเดิมที่เลือกไว

การเลือกใชสีแบบตางๆ
การเลือกใชสีจาก Color Picker : หนาตางสำหรับเลือกสี 

คลิกเลือกความเขมของสี 
ที่ตองการนำมาใช

คลิกเลือกเพื่อแสดงสีที่
สามารถใชออกแบบเว็บ

ไซตเทานั้น

คลิกเลือกเพื่อเลือกโทนสีที่ตองการนำมาใชงาน

สัญลักษณเตือนวาสีที่เลือกไมสามารถใช
งานไดกับงานที่ทำอยู

เลือกใชสีกับ Swatches ที่มีอยู

เลือกโหมดสี HSB RGB และ CMYK 
ซึ่งจะสอดคลองกับงานที่ทำงาน

ใสโคดสีสำหรับใชงานดานการออกแบบบนเว็บเพจ



สีใหมที่เลือกไว

แดรกเมาสเพื่อเลือกสีผสมเอง

การเลือกใชสีแบบตางๆ การเลือกใชสีจาก Panel Color : หนาตางสำหรับปรับแตงสี 

คลิกเลือกความเขมของสี 
ที่ตองการนำมาใช

คลิกเลือกโทนสีที่ตองการนำมาใชงาน

ผสมสีดวยการกรอกคาสี

โคดสีคา (HEX) 
สามารถนำไปใชตอในโปรแกรมอื่นๆได

ปรับแตงสีเสน

ไมเติมสีใดๆ

เลือกใชงานสีขาวดำ



การเลือกใชสีแบบตางๆ การเลือกใชโหมดสีจาก Panel Color : หนาตางสำหรับเลือกสี 

การเลือกใชโหมดสีตางๆ

ปรับเลือกใชสีที่ตรงกันขามกับสีที่ใช
อยู

ปรับเลือกใชสีที่ใกลเคียงกับสีที่ใชอยู

เพิ่มสีที่ผสมไวในพาเนล Swatches

Grayscale สำหรับการทำงานไลโทนขาวดำ

RGB สำหรับการทำงานที่ตองแสดงภาพบนหนาจอ

CMYK สำหรับการทำงานสิ่งพิมพ

HSB
สำหรับการทำงานที่ตองเลือกใชสีแบบผสม

ตามระดับความสวาง

Web safe RGB สำหรับงานออกแบบเว็บ



การเลือกใชสีแบบตางๆ การเลือกใชโหมดสีจาก Swatches : หนาตางสำหรับเลือกสี  

ชุดสีพื้นฐานในโปรแกรมที่ใช

งานไดทันที

สรางกลุมชุดสีใหม

เลือกชุดสีแบบอื่นๆ จาก 

Swaches Libraries
เพิ่มสีที่ผสมไวในพาเนล Swatches

เลือกการแสดงผลของสี

ในพาเนล Swaches

สรางสีใหมเพิ่ม

ลบสีออกจากพาเนล

การเลือกใชสีจาก 

Swaches Libraries



การเลือกใชสีแบบตางๆ การเพิ่มสีใน Swatch

1

ใชเครื่องมือ Selection tool คลิก

ที่ Object ที่ตองการสรางกลุมสี

2 คลิิกที่ สรางกลุมชุดสีใหม

3

ตั้งชื่อกลุมสี

4

กลุมสีที่เราสราง

ขึ้นมาใหม



การเลือกใชสีแบบตางๆ การใชงาน Color Guide

1

ใชเครื่องมือ Selection tool คลิก

ที่ Object ที่ตองการสรางกลุมสี

3 คลิก edit 
คลิิกเพื่อกำหนดกลุมสีใหม2

4 ปรับสีตามความตองการ

5 ผลลัพธของการปรับสี



ตกแตงเสนขอบในแบบตางๆ



รูจักกับเสนขอบ
นอกจากการลงสีพื้นใหวัตุแลวยังลงสีขอบไดอีกดวย สามารถกำหนดสีเสน ไมวาจะเปนสีพื้น หรือสีแบบลวดลายตอเนื่อง 

(Pattern) นอกจากนั้นยังสามารถเพิ่มลดขนาดของเสนไดดวย มีขั้นตอนดังนี้ 

ใชเครื่องมือ Selection Tool 

คลิกเลือกวัตถุที่ตองการ

เปดพาเนล Color ขึ้นมา
1

2

คลิกเลือก Stroke เพื่อปรับเสน3

แดรกเมาสปรับสีไดตาม

ตองการ หรือคลิกที่เลือกสี

จากแถบสเปกตรัม

ดานลาง

4
ลักษณะของเสนขอบ

เริ่มตน ที่มีบาง

เกินไป

5



รูจักกับเสนขอบ

คลิกเมนู Windows>Stroke 

เพื่อเปดพาเนล Stroke ขึ้นมา

6

แดรกเมาสปรับสีไดตาม

ตองการ หรือคลิกที่เลือกสี

จากแถบสเปกตรัม

ดานลาง

9

ไดเสนขอบหนาขึ้นดังภาพ8

เปดพาเนล Color ขึ้นมา7

สีขอบที่มีการปรับแตง

10



กำหนดคุณสมบัติเสนขอบบนพาเนล Stroke

กำหนดขนาดเสน 

 

 

 

 

 

 

 

สรางเสนประและควบคุมระยะหางของเสนประ

สรางหัวลูกศร

เลือกรูปแบบของเสน Stroke

กำหนดลักษณะให

เสนและรูปแบบมุม

กำหนดตำแหนง Strok บนเสน Path

กำหนดหัวลูกศร

ระบุตำแหนงของหัวลูกศร



Workshop Stroke

สรางเครื่องเลนเสียง

ดวยเครื่องมือ Stroke



สราง Profile Stroke ไวใชเอง
ใชเครื่องมือ Pen tool วาดเสนตรงขึ้นมา พรอมกับปรับ

ขนาดใหหนาขึ้นดวยเครื่องมือ         (Width Tool)
1

เปดพาเนล Stroke ขึ้นมา 

หลังจากนั้นคลิกปุม         Profile 

2

ตั้งชื่อ Stroke แลวคลิกปุม OK  
3

ทดลองสรางโลโกจาก Stroke

4



Workshop Stroke

สราง Logo 

ดวยเครื่องมือ Stroke



การวาดเสนดวย Bob Brush Tool

เปดภาพที่ตองการ

ตกแตงขึ้นมา

1

คลิกเลือกเครื่องมือ Blob Brush Tool

2

คลิกเลือกสีเสนที่ตองการ

3

แดรกเมาสวาด

ตามรูปภาพ

4



ทำความรูจักกับ Layers
ดวย Adobe Illustrator



รูจักกับ Layers
เลเยอร (Layer) คือชั้นของวัตถุที่สรางขึ้นจากเครื่องมือใน Illustrator โดยวัตถุแตละชิ้นจะวางซอนกันตามลำดับ วัตถุที่สรางใหม

จะอยูดานบนเสมอ การจัดการกับเลเยอรที่ดีจะชวยใหสามารถวาดภาพไดงายขึ้น และเลือกปรับแตงชิ้นงานในภายหลังได

ดับเบิ้ลคลิกเพื่อเปลี่ยนชื่อเลเยอร 

คลิกเพื่อเลือกทำงานกับวัตถุในเลเยอร

สัญลักษณแสดงวัตถุในเลเยอร ถูกเลือกทำงานอยู

คลิกเพื่อล็อคการปรับแตงวัตถุในเลเยอร

คลิกเพื่อซอนหรือแสดงวัตถุยอยในเลเยอรที่ทำงานอยู

คลิกเพื่อซอนหรือแสดงวัตถุในเลเยอร

คลิกเพื่อลบเลเยอร

คลิกเพื่อเพิ่มเลเยอร

คลิกเพื่อเพิ่มเลเยอรยอยใหม

คลิกเพื่อสรางหรือยกเลิก Mask

คลิกเพื่อคนหาวัตถุที่เลือกทำงานอยู

ขอความแสดงประเภทของวัตถุในเลเยอรยอย



การปรับมุมมองของพาเนล Layers
คลิกปุม        ขางพาเนล Layers 
เพื่อเรียกคำสั่งเสริม

คลิกเพื่อเลือกทำงาน
กับวัตถุในเลเยอร

1

2

แสดงวัตถุเฉพาะใน
เลเยอรเทานั้น

กำหนดการแสดงภาพใน 
Layer Thumbnail

คลิกเพื่อแสดงและซอนภาพ
ใน Layer Thumbnail ของ
วัตถุประเภทตางๆ



การปรับมุมมองของพาเนล Layers
คลิกปุม        ขางพาเนล Layers 
เพื่อเรียกคำสั่งเสริม

คลิกเพื่อเลือกทำงาน
กับวัตถุในเลเยอร

1

2

แสดงวัตถุเฉพาะใน
เลเยอรเทานั้น

กำหนดการแสดงภาพใน 
Layer Thumbnail

คลิกเพื่อแสดงและซอนภาพ
ใน Layer Thumbnail ของ
วัตถุประเภทตางๆ

ดับเบิ้ลคลิกบนพื้นที่วางของ
เลเยอรเพื่อเปดหนาตาง 
Layer Option ขึ้นมา



การปรับมุมมองของพาเนล Layers

กำหนดวัตถุใน
เลเยอรเปน Template 

ซึ่งจะไมสามารถปรับแตง
ได

คลิกเพื่อแสดงวัตถุ 

คลิกเพื่อแสดงวัตถุปกติ 
หรือวัตถุแบบเสนเคาราง

ตั้งชื่อใหเลเยอรที่เลือก

กำหนดสีใหกับเลเยอร

คลิกเพื่อปรับภาพใหจางลง 
ซึ่งใชไดกับภาพแบบบิต
แมพเทานั้น

คลิกเพื่อล็อคเลเยอร

คลิกเพื่อเปด/ปด การพิมพ
ของภาพในเลเยอร



การปรับแต่งและแก้ไขรูปทรงด้วยเอฟเฟ็กต์
ด้วย Adobe Illustrator



ปรับแต่งและแก้ไขรูปทรงด้วยเอฟเฟ็กต์
Gaussian Blur

ใช้เครื่องมือ Select Tool คลิก  
เลือกรูปทรงที่ต้องการปรับแต่ง

1



ปรับแต่งและแก้ไขรูปทรงด้วยเอฟเฟ็กต์
Gaussian Blur

1

คลิกเมนู Effect > Blur > Gaussian Blur2

ก าหนดค่า Radius ได้ตามต้องการ3

ลักษณะของภาพที่
ได้มีความนุ่มนวลขึ้น

4



ปรับแต่งและแก้ไขรูปทรงด้วยเอฟเฟ็กต์
Drop Shadow

คลิกเลือกวัตถุที่ตอ้งการใส่เงา1



ปรับแต่งและแก้ไขรูปทรงด้วยเอฟเฟ็กต์
Drop Shadow

คลิกเมนู Effect > Stylize > Drop Shadow 2

ก าหนดค่าต่างๆโดยเลือก
โหมดเป็น Multiple3

ก าหนดค่า Opacity เพ่ือเพ่ิม
หรือลดความเข้มของเงา

4

ค่าของ X และ Y ก าหนด  
ต าแหน่งของเงา5

ก าหนดเพ่ือเพ่ิมหรือลดความฟุ้งให้เงา 6 เลือกสีของเงา และก าหนด
ค่า Darkness ลดความเข้ม
ของเงา

7



ปรับแต่งและแก้ไขรูปทรงด้วยเอฟเฟ็กต์
Drop Shadow

ลักษณะของเงาที่ได้หลัง
จากปรับแต่งค่าต่างๆ แล้ว

8



ปรับแต่งและแก้ไขรูปทรงด้วยเอฟเฟ็กต์
ตัวอย่างค าสั่งอื่นๆ ในกลุ่ม Stylize
Feather : ปรับวัตถุให้มีความฟุ้ง นุ่มนวล 



ปรับแต่งและแก้ไขรูปทรงด้วยเอฟเฟ็กต์
ตัวอย่างค าสั่งอื่นๆ ในกลุ่ม Stylize
Inner Glow : สร้างเงาสีต่างๆให้สะท้อนเข้าด้านในหรือด้านนอก



ปรับแต่งและแก้ไขรูปทรงด้วยเอฟเฟ็กต์
ตัวอย่างค าสั่งอื่นๆ ในกลุ่ม Stylize
Outer Glow : สร้างเงาสีต่างๆให้สะท้อนออกไปด้านนอก



สร้างภาพต่อเนื่องด้วย Blend Tool
Blend Tool เป็นเครื่องมือส าหรับสร้างภาพต่อเนื่องระหว่างวัตถุ 2 ชิ้น

ขึ้นไป รูปทรงจะค่อยๆ เปลี่ยนทั้งรูปร่างและสี ไปเป็นอีกชิ้นงานหนึ่ง
การใช้งาน Blend Tool สร้างวัตถุแบบต่อเนื่อง

คลิกเครื่องมือ Blend Tool1

คลิกเลือกภาพเร่ิมต้น 2

คลิกเลือกภาพปลายทาง 3



สร้างภาพต่อเนื่องด้วย Blend Tool
การใช้งาน Blend Tool สร้างวัตถุแบบต่อเนื่อง

ได้ภาพต่อเนื่องเรียบร้อยแล้ว4



ใช้งาน Symbol และ Graph
ด้วย Adobe Illustrator



ใช้งาน Symbol และ Graph
รู้จักกับ Symbol

Symbol เป็นรูปภาพส าเรจ็รูปที่นิยมน ามาใช้ตกแต่งงานต่างๆ ให้สมบูรณ์ 
ข้อดีของ Symbol คือสะดวกรวดเรว็และยังช่วยลดขนาดไฟล์งานใหเ้ล็กลงอีกด้วย
การใช้งานท าได้โดย คลิกที่ Window > Symbol หรือ กดปุ่ม Shift + Ctrl + F11 

3D Symbols                                          Arrows                                        Artistic Textures



ใช้งาน Symbol และ Graph
รู้จักกับ Symbol

Flowers                               Mad Science Web Icon



ใช้งาน Symbol
เราสามารถน า Symbol ต่างๆ มาสร้างสรรค์งานได้หลากหลาย ทั้งการ

ใช้ Symbol เพียงอย่างเดียว หรือจะน าไปใช้งานร่วมกับภาพกราฟิกอื่นๆ



ใช้งาน Symbol
สามารถใช้งาน Symbol ได้โดยการแดรกเมาส์ไปวางบนอาร์ตบอร์ด ดังนี้

คลิกเลือก Symbol 
ชุดอื่นๆที่ต้องการ

คลิกเพื่อวาง Symbol ลงบนอาร์ตบอร์ด

ยกเลิกคุณสมบัติของ Symbol ก าหนดคุณสมบัติ Symbol ส าหรับ
งานที่ต้อง Export ไปใช้กับโปรแกรมอื่น

สร้าง Symbol ใหม่

ลบ Symbol ที่ใช้งานอยู่



ใช้งาน Symbol
การสร้าง Symbol ใหม่

วาดรูปทรงใหม่
ตามต้องการ

1

เปิดพาเนล Symbol 
พร้อมกับแดรกเมาส์ย้าย
รูปทรงที่วาดมาเก็บไว้

2



ใช้งาน Symbol และ Graph

ตั้งชื่อให้กับ Symbol พร้อมเลือก    
ประเภท Symbol เป็น Movie Clip3

เมื่อคลิกปุ่ม OK ก็จะ
ได้ Symbol ใหม่4



สร้างกราฟด้วยกลุ่มเครื่องมือ Graph 
การสร้างและปรับแต่งกราฟ

คลิกที่เครื่องมือ Column Graph    
Tool เพ่ือสร้างกราฟแท่ง1

แดรกเมาส์บนอาร์ตบอร์ด
เพ่ือก าหนดขนาดของกราฟ2



สร้างกราฟด้วยกลุ่มเครื่องมือ Graph 
การสร้างและปรับแต่งกราฟ

กรอกชื่อแถวและชื่อคอลัมน์ให้กราฟ    
หากชื่อแถวและคอลัมน์เป็นตัวเลขให้
กรอกภายใต้เครื่องหมาย “Y2011”

3

กรอกข้อมูลของกราฟ เมื่อเสร็จ
แล้วคลิกปุ่ม       Apply

4



สร้างกราฟด้วยกลุ่มเครื่องมือ Graph 
การสร้างและปรับแต่งกราฟ

ได้กราฟแท่งตามข้อมูลที่ก าหนดไว้ 5



สร้างกราฟด้วยกลุ่มเครื่องมือ Graph 
เครื่องมือส าหรับการปรับแต่งรูปแบบของกราฟเบื้องต้น

Import Data : ใช้ส าหรับดึงข้อมูลอื่นๆ เช่น Excel หรือข้อมูลที่แยกคอลัมน์ใน Notepad 
มาใช้สร้างกราฟ

Transpose Row/Column  :  คลิกเพื่อสลับข้อมูลระหว่างแถวและคอลัมน์

Switch X/Y  : คลิกเพื่อสลับแกนข้อมูลส าหรับกราฟแบบ Scatter Graph

Call Style  : ใช้ก าหนดรูปแบบตารางกรอกข้อมูล โดยระบุจ านวนทศนิยมที่ต้องการ และความกว้าง
ของตารางกรอกข้อมูล

Revert  : ยกเลิกการแก้ข้อมูลในเซลล์ล่าสุด

Apply  : ใช้ส าหรับใส่ข้อมูลในตารางไปสร้างกราฟ



การท างานกับตัวอักษร (Type)
ด้วย Adobe Illustrator



การท างานกับตัวอักษร (Type)
รู้จักกับเครื่องมือกลุ่ม Type

Type Tool :  เป็นเครื่องมือส ำหรับพิมพ์ข้อควำมที่ใช้งำนบ่อยที่สุด สำมำรถปรับแต่งใส่สีเส้นขอบ
หรือย่อ ขยำยได้ตำมต้องกำร



การท างานกับตัวอักษร (Type)
การสร้างข้อความด้วยเครื่องมือ Type Tool

ใช้ Type Tool 
คลิกบนอำร์ตบอร์ด
เพ่ือก ำหนดจุดเริ่มต้น
ของข้อควำม 1

ก ำหนดรูปแบบตัวอักษร สี และ
ขนำดบนพำเนล ได้ตำมต้องกำร 2

พิมพ์ข้อควำมที่ต้องกำรลงไป
3 กด Ctrl + Enter เมื่อพิมพ์ข้อควำมแล้วจะ

ปรำกฏ Bounding Box ล้อมรอบข้อควำม

4



การท างานกับตัวอักษร (Type)
รู้จักกับเครื่องมือกลุ่ม Type

Area Type Tool :  เป็นเครื่องมือส ำหรับสร้ำงข้อควำมแบบย่อหน้ำแนวนอน บังคับให้ข้อควำมอยู่
ภำยในขอบเขตของรูปทรงท่ีสร้ำงไว้ได้ด้วย



การท างานกับตัวอักษร (Type)
รู้จักกับเครื่องมือกลุ่ม Type

Type On a Path Tool  และ         Vertical Type On a Path Tool :  เป็นเครื่องมือส ำหรับพิมพ์
ตัวอักษรให้ไหลไปตำมแนวเส้น Path สำมำรถปรับแต่งทิศทำงได้ตำมต้องกำร



การท างานกับตัวอักษร (Type)
รู้จักกับเครื่องมือกลุ่ม Type

Vertical Type Tool :  เป็นเครื่องมือส ำหรับพิมพ์ตัวอักษรในแนวตั้ง เหมำะส ำหรับข้อควำมสั้นๆ



การท างานกับตัวอักษร (Type)
รู้จักกับเครื่องมือกลุ่ม Type

Vertical Area Type Tool  : ใช้พิมพ์ตัวอักษรในแนวตั้ง ในพ้ืนที่ที่สร้ำงไว้ ตัวอักษรจะอยู่ภำยใน
ขอบเขตของรูปทรงที่สร้ำงไว้



การพิมพและ การ Export Artwork
ดวย Adobe Illustrator



ทำความรูจักกับพื้นที่การพิมพ

1 เขาไปที่เมนู View > Show Tiling 2 แสดงขอบเขตการพิมพ 3 ปรับแตงชิ้นงานใหพอดีสำหรับพิมพ



การ Export Artwork : JPG

1 ไปที่ file > Export 2 เลือก Type : .JPG 3 เลือก Color Model และ Quality

กำหนดชุดสี

กำหนดขนาดรูปภาพ

กำหนดความละเอียดใน

การแสดงผลของภาพ

บนจอ งานพิมพแนะนำ 

300 ppi

เลือก Type ที่

ตองการบันทึก



การ Export Artwork : PDF

1 ไปที่ file > Save As 2 เลือก Type : .PDF 3 เลือก Color Model และ Quality

PDF for Illustrator 

สามารถแกไขไดอีกครั้ง

ในโปรแกรม Ai

PDF ขนาดเล็ก เหมาะ

สำหรับงานอัพโหลดขึ้นสู

ระบบอินเตอรเน็ต และ

สงอีเมลPDF คุณภาพสูง เหมาะ

สำหรับสงงานพิมพ จัด

ทำคูมือ เอกสารตางๆ



การ Export Artwork : PDF

4 บันทึกไฟลเปนชนิด PDF for Adobe Illustrator

กรณีเลือก PDF for Illustrator 
สามารถแกไขไดอีกครั้งในโปรแกรม 
Adobe Illustrator

กำหนดเพื่อใหแกไขและปรับแตงไฟล PDF ดวย Illustrator CS6-CC ได 

หลังจากบันทึกแลว

เพื่อแสดง Thumnail เมื่อเปดไฟลดวยโปรแกรม Acrobat

เพื่อบีบอัดไฟลใหแสดงบนเว็บเพจไดรวดเร็วขึ้น

เพื่อแสดงไฟลหลังจากบันทึก

เพื่อใหคงเยอรงานของไฟลเดิมไวดวย

บันทึกไฟล



การ Export Artwork : PDF
5

บันทึกไฟลเปนชนิด PDF for Adobe Illustrator กรณีเพิ่มความ

ปลอดภัย และสงโรงพิมพ

เลือกสัญลักษณทางการพิมพที่ตองการแสดง

บนไฟล PDF

กำหนด Password สำหรับไฟล PDF

กำหนด Password สำหรับปรับแตงไฟล PDF

กำหนดคาสำหรับความละเอียดของไฟลที่

สามารถสั่งพิมพได

บันทึกไฟล

กำหนดคาสำหรับความละเอียดของไฟลที่

สามารถสั่งพิมพได
สงโรงพิมพ
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